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About This Guide
This manual introduces the KDE 4 desktop of openSUSE®. It helps you perform key
tasks. It is intended mainly for end users who want to make efficient use of KDE in
everyday life.

Many chapters in this manual contain links to additional documentation resources. This
includes additional documentation that is available on the system as well as documen-
tation available on the Internet.

For an overview of the documentation available for your product and the latest docu-
mentation updates, refer to http://www.novell.com/documentation/
opensuse111 or to the following section.

1 Available Documentation
We provide HTML and PDF versions of our books in different languages. The following
manuals for users and administrators are available on this product:

Start-Up (↑Start-Up)
Guides you through the installation and basic configuration of your system. For
newcomers, the manual also introduces basic Linux concepts such as the file system,
the user concept and access permissions and gives an overview of the features
openSUSE offers to support mobile computing. Provides help and advice in trou-
bleshooting.

KDE User Guide (page 1)
Introduces the KDE desktop of openSUSE. It guides you through using and config-
uring the desktop and helps you perform key tasks. It is intended mainly for users
who want to make efficient use of KDE as their default desktop.

GNOME User Guide (↑GNOME User Guide)
Introduces the GNOME desktop of openSUSE. It guides you through using and
configuring the desktop and helps you perform key tasks. It is intended mainly for
end users who want to make efficient use of GNOME desktop as their default
desktop.

http://www.novell.com/documentation/opensuse111
http://www.novell.com/documentation/opensuse111


Application Guide (↑Application Guide)
Learn how to use and configure key desktop applications on openSUSE. This guide
introduces browsers and e-mail clients as well as office applications and collabora-
tion tools. It also covers graphics and multimedia applications.

Reference (↑Reference)
Gives you a general understanding of openSUSE and covers advanced system ad-
ministration tasks. It is intended mainly for system administrators and home users
with basic system administration knowledge. It provides detailed information about
advanced deployment scenarios, administration of your system, the interaction of
key system components and the set-up of various network and file services open-
SUSE offers.

Security Guide (↑Security Guide)
Introduces basic concepts of system security, covering both local and network se-
curity aspects. Shows how to make use of the product inherent security software
like Novell AppArmor (which lets you specify per programwhich files the program
may read, write, and execute) or the auditing system that reliably collects informa-
tion about any security-relevant events.

Lessons For Lizards
A community book project for the openSUSE distribution. A snapshot of the
manual written by the open source community is released on an equal footing with
the Novell/SUSE manuals. The lessons are written in a cook book style and cover
more specific or exotic topics than the traditional manuals. For more information,
see http://developer.novell.com/wiki/index.php/Lessons
_for_Lizards.

In addition to the comprehensive manuals, several quick start guides are available:

KDE Quick Start (↑KDE Quick Start)
Gives a short introduction to the KDE desktop and some key applications running
on it.

GNOME Quick Start (↑GNOME Quick Start)
Gives a short introduction to the GNOME desktop and some key applications
running on it.

Novell AppArmor Quick Start
Helps you understand the main concepts behind Novell® AppArmor.
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Find HTML versions of most openSUSEmanuals in your installed system under /usr/
share/doc/manual or in the help centers of your desktop. Find the latest documen-
tation updates at http://www.novell.com/documentation where you can
download PDF or HTML versions of the manuals for your product.

For information where to find the books on your installation media, refer to the Release
Notes of this product. The Release Notes are available from your installed system under
/usr/share/doc/release-notes/ or in the help centers of your KDE or
GNOME desktop.

2 Feedback
Several feedback channels are available:

• To report bugs for a product component or to submit enhancements requests, please
use https://bugzilla.novell.com/. If you are new to Bugzilla, you
might find the Submitting Bug Reports article—available under http://en
.opensuse.org/Submitting_Bug_Reports helpful. Frequently asked
questions on reporting bugs are available under http://en.opensuse.org/
Bug_Reporting_FAQ.

• We want to hear your comments and suggestions about this manual and the other
documentation included with this product. Please use the User Comments feature
at the bottom of each page of the online documentation and enter your comments
there.

3 Documentation Conventions
The following typographical conventions are used in this manual:

• /etc/passwd: directory names and filenames

• placeholder: replace placeholder with the actual value

• PATH: the environment variable PATH

• ls, --help: commands, options, and parameters
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• user: users or groups

• Alt, Alt + F1: a key to press or a key combination; keys are shown in uppercase as
on a keyboard

• File, File > Save As: menu items, buttons

• Dancing Penguins (Chapter Penguins, ↑Another Manual): This is a reference to a
chapter in another manual.

4 About the Making of This Manual
This book is written in Novdoc, a subset of DocBook (see http://www.docbook
.org). The XML source files were validated by xmllint, processed by xsltproc,
and converted into XSL-FO using a customized version of NormanWalsh's stylesheets.
The final PDF is formatted through XEP from RenderX.

5 Source Code
The source code of openSUSE is publicly available. To download the source code,
proceed as outlined underhttp://www.novell.com/products/suselinux/
source_code.html. If requested we send you the source code on a DVD.We need
to charge a $15 or €15 fee for creation, handling and postage. To request a DVD of the
source code, send an e-mail to sourcedvd@suse.de [mailto:sourcedvd@suse
.de] or mail the request to:

SUSE Linux Products GmbH Product Management openSUSEMaxfeldstr. 5 D-90409
Nürnberg Germany

6 Acknowledgments
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scale to promote the development of Linux. We thank them for their efforts—this dis-
tribution would not exist without them. Furthermore, we thank Frank Zappa and Pawar.
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Have a lot of fun!
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Part I. Introduction





1Getting Started with the KDE
Desktop
This chapter assists you in becoming familiar with the KDE desktop of your open-
SUSE®. If you have not yet installed your system, refer to Chapter 1, Installation with
YaST (↑Start-Up).

KDE stands for K Desktop Environment and is an easy-to-use graphical user interface
graphical user interface that communicates with the underlying Linux system to access
and manage files, folders, and programs. It has many applications designed to help you
in your daily work. KDE also offers many choices to modify your desktop according
to your needs and wishes. Read more about configuring your desktop in Chapter 3,
Customizing Your Settings (page 37).

The following description is based on the default configuration of the KDE 4 desktop
shippedwith your product. If you or your system administrator has modified the defaults,
some aspects may be different, such as appearance or keyboard shortcuts.

1.1 Logging In
If more than one user account is configured on your computer, usually all users must
authenticate—unless Auto Login is configured for a certain user. Auto login logs the
user in to the desktop environment automatically on boot. This feature can be enabled
or disabled during installation or at any time using the YaST user management module.
For more information, see Chapter 5, Managing Users with YaST (↑Start-Up). If your
computer is run in a network environment and you are not the only person using the
machine, you are usually prompted to enter your username and password when you
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start your system. If you did not set up your system and your user account yourself,
check with your system administrator for your username and password.

The appearance of the login screen depends on the product you use and on the desktop
environment installed on your system. The login process is managed by an application.
For KDE, it is KDM. If the GNOME desktop is additionally installed on your system,
it may be GDM.

To start a normal login, enter your username and password. If desktops other than KDE
are installed, you can select which desktop environment to start by clicking the Session
Typing menu item at the bottom of the login screen. Press Enter to proceed. For infor-
mation on how to log out or switch to another desktop, see Section 1.3, “Leaving Your
System” (page 11) and Section 1.4, “Switching Desktops” (page 13).

Figure 1.1 A KDM Login Screen

If your system administrator has created an encrypted home directory for you (which
is useful as a protection against theft or unauthorized removal of the hard disk), your
home directory is mounted on login. After login, you can directly access the data as
usual—without entering another password.

NOTE: Connecting to an Active Directory Server

To access shared network resources, you can also authenticate a KDE client
machine against an Active Directory server. For further details, refer to Chap-
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ter 5, Accessing Network Resources (page 63). If your machine is configured
for this kind of authentication, the login screen also provides an additional
field. In this case, proceed as follows during login:

1. Select the domain from the list.

2. Enter your Windows* username.

3. Enter your Windows password and press Enter.

1.2 Exploring the Desktop
Components

After logging in to KDE for the first time, you see the KDE desktop. It consists of the
following basic elements:

Figure 1.2 Example KDE Desktop

Desktop Icons and Desktop Folder Desktop icons represent files, directories, ap-
plications, functions, and removable media, like CDs or DVDs. Click an icon on the
desktop to access its associated program or application. By default, your desktop icons
are shown in aDesktop Folder, a transparent region of the screen showing the contents
of the Desktop folder in your home directory. If you drag an icon from the Desktop
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Folder and drop it on another part of the desktop, it appear as widget that you can tilt,
enlarge or minimize. Widgets are small applications that can be integrated into your
desktop. Right-click to open a context menu to access the icon properties, or to remove
the icon. For more information, see Configuring Widgets (page 42).

Desktop Context Menu: Right-click an empty area on the desktop to access the
context menu for configuring the appearance of the desktop, adding panels or widgets
to the desktop, locking the widgets in their current position, or for leaving the current
session or locking the screen.

KDE Panel: The panel (in KDE also called “Kicker”) is a bar, typically located at
the top or the bottom of the screen. By default, the panel of your KDE desktop consists
of the following areas (from left to right): quick launcher with the main menu icon on
the left and further program icons, pager (desktop previewer), taskbar, and system tray.
You can add or remove icons in the panel and customize the appearance of the panel
as well as its location on the desktop. If you hold your mouse pointer over an icon in
the panel, a short description is displayed.

Quick Launcher: The quick launcher contains the main menu button and some
larger icons that are shortcuts to frequently used programs, folders, and functions.

MainMenu Button: Use the icon at the far left of the panel to open a menu holding
a search function at the top and several tabs at the bottom. The Applications tab shows
all installed programs in a function-oriented menu structure which makes it easy to find
the right application for your purpose even if you do not know the application names
yet. For more information, refer to Section 2.1.1, “Using the Main Menu” (page 15) .

Pager (Desktop Previewer): Between the quick launcher and the taskbar, find a
miniature preview that shows your virtual desktops (if not configured otherwise, they
are numbered). openSUSE allows you to organize your programs and tasks on several
desktops, which minimizes the number of windows to arrange on the screen. To switch
between the virtual desktops, click one of the symbols in the pager. For more informa-
tion, refer to Section 2.6, “Using Virtual Desktops” (page 28).

Taskbar: By default, all started applications and open windows are displayed in
the taskbar, which allows you to access any application regardless of the currently active
desktop. Click to open the application. Right-click to see options for moving, restoring,
or minimizing the window.

System Tray: This rightmost part of the panel usually holds some smaller icons,
including the system clock displaying time and date, the volume control, and several
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other helper applications such as the device notifier, informing you about recently
plugged or inserted devices such as USB sticks, external hard disks, cameras, CDs, or
DVDs. For more information, refer to Section 2.5, “Accessing Removable Media and
External Devices” (page 27).

The integration and handling of desktop objects has changed from KDE 3.x to KDE 4,
which now uses a new desktop and panel interface tool called Plasma. Plasma supports
desktop widgets (also called “plasmoids”), similar to Apple’s dashboard widgets. Learn
more about the key desktop objects in the following sections.

1.2.1 Locking and Unlocking Desktop
Objects

With KDE 4, desktop elements can be locked in their current position to prevent them
from being moved around on the desktop. As long as the desktop elements are locked,
you cannot add, move, or remove any objects to and from your desktop.

To lock or unlock the desktop elements, right-click an empty space on the desktop and
select Lock Widgets or Unlock Widgets.

Figure 1.3 Unlocking Desktop Objects

Find how to add, remove and configure widgets and change numerous desktop elements
in Chapter 3, Customizing Your Settings (page 37).
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1.2.2 Desktop Icons
By default, theDesktop Folder showing the contents of the~/Desktop folder, displays
the following icons by default:

Figure 1.4 KDE Desktop Folder

My Computer
TheMy Computer icon is very useful for viewing the most important information
about your hardware, network status, disks (hard disks, removable media, and ex-
ternal devices), operating system, and some common folders at one glance. For
example, find processor type and speed listed there, information about your RAM
and the current swap status, or your graphics card. OS Information lists the most
important information about your operating system such as the Kernel version in-
cluded, the current user, version number and type of the operating system, and the
KDE version number. openSUSE ships with a number of further tools (either
graphical or command line tools) that you can use to get more detailed information
about your system. If you need detailed hardware information about your system,
use the YaST hardware probing, described in Section “Probing Your Hardware”
(Chapter 2, Setting Up Hardware Components with YaST, ↑Start-Up).

Firefox
Opens the Firefox Web browser. For more information, refer to Chapter 17,
Browsing with Firefox (↑Application Guide).
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Office
Opens a new OpenOffice.org document. For an introduction to the office suite,
refer to Chapter 1, The OpenOffice.org Office Suite (↑Application Guide).

openSUSE
Opens the SUSEgreeter which holds introductory information and links to various
information sources about openSUSE.

Help
Starts Konqueror Web browser and takes you to the help page of the openSUSE
community [http://help.opensuse.org] from where you can access var-
ious documentation resources, mailing lists, Web forums or chats with members
of the openSUSE community. Find more information about accessing and using
help resources (integrated with your system or on the Web) in Chapter 12, Help
and Documentation (↑Start-Up).

1.2.3 Panel Icons
The quick launch area of your panel as shipped with openSUSE includes the following
icons by default:

Figure 1.5 Panel: Quick Launch Area

Main Menu Icon
Opens the main menu, similar to the Microsoft* Windows start menu.

Device Notifier Icon
Informs you about recently plugged or inserted devices such as USB sticks, external
hard disks, cameras, CDs, or DVDs. For more information, refer to Section 2.5,
“Accessing Removable Media and External Devices” (page 27).

Dolphin Icon
Opens Dolphin, the default file manager.

Apart from the larger icons in the quick launcher, the panel also holds a number of
smaller icons in the system tray area on the right:
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Figure 1.6 Panel: System Tray

Klipper
KDE's clipboard tool that “remembers” the last entries you have moved to the
clipboard. To view the clipboard contents, click the Klipper icon or press Ctrl +
Alt + V. The most recent entry is listed on top and is marked as active with a black
check mark. To insert the active clipboard entry again, move the mouse pointer to
the target application, then middle-click. For more information, see Section 2.3,
“Moving Text between Applications” (page 24).

KMix
Your desktop's default mixer, KMix helps you to control sound on your desktop
after your sound card has been detected and configured with YaST, the central tool
for installation and configuration of your system. By default, clicking the KMix
icon in the system tray shows the master controller with which to increase or de-
crease the overall volume. For more information, refer to Section “Mixers”
(Chapter 22, PlayingMusic andMovies: amaroK, Kaffeine andMore, ↑Application
Guide).

openSUSE Updater
Helps you keeping your system up to date. When you connect to the Internet, the
openSUSEUpdater automatically checks whether software updates for your system
are available. The applet icon changes color and appearance depending on the
availability of updates for your system. For detailed information about how to install
software updates with openSUSEUpdater and how to configure openSUSEUpdater,
refer to Chapter 5, YaST Online Update (↑Reference).

KNetworkManager
If you manage your network connection with NetworkManager and have enabled
the use of NetworkManager in YaST, the KNetworkManager icon also appears in
your system tray be default. Use it to change and configure network connections.
For detailed information, refer to Chapter 10,Using NetworkManager (↑Start-Up).

Clock
For information about the current date and time, click the clock in the system tray
or hove your mouse pointer over the clock. You can change the clock settings (such
as appearance or additional data to be displayed) from the context menu available
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upon right-click. If you need to update the system time, start YaST and select System
>Date and Time. Refer to Section “Clock and Time Zone” (Chapter 1, Installation
with YaST, ↑Start-Up) for more information.

Lock Screen
Locks your screen and starts the screen saver. Access to the session can only be
regained with a password.

Log Out
Logs you out and ends your current KDE session. If not configured otherwise in
the KDE 4 Personal Settings, (see Adjusting the Session Handling (page 55), the
session manager will restore the currently open windows by default next time you
log in to KDE.

Cashew Icon
Give access to panel configuration options. For more information, see Customizing
the Panel (page 46).

Of course, you can also change the way your KDE desktop looks and behaves to suit
your own personal tastes and needs. To learn how to configure individual desktop ele-
ments or how change the overall appearance and behavior of your desktop, refer to
Section 3.1, “The Personal Settings” (page 37).

If you would like to start working with your desktop now, continue reading at Chapter 2,
Working with Your Desktop (page 15). Otherwise you can leave your system with one
of the possibilities described below.

1.3 Leaving Your System
When you have finished using the computer, there are several options how to leave
your system: some of them will leave the system running, others will shutdown the
computer. If your system provides powermanagement, you can also choose tosuspend
your computer—in this state, it will consume considerably less power that usual but it
will start much faster than after a complete shutdown and boot process. For more infor-
mation, refer to Chapter 9, Controlling Your Desktop’s Power Management (page 87).

You can access all the options to leave your session or your system from the main menu.
Click the main menu icon on the left and switch to the Leave tab. Select one of the
following options:
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Logout
Ends your current session and leaves your system running. If not configured other-
wise in the KDE 4 Personal Settings (see Adjusting the Session Handling (page 55),
the session manager will restore the currently open windows by default next time
you log in to KDE. Find more information about the session manager and configu-
ration options at Adjusting the Session Handling (page 55).

Lock
Prevents unauthorized access by others by locking your screen and starting a screen
saver. Access to the session can only be regained with a password. To unlock, enter
your normal login password. For information about configuring your screen saver,
see Configuring the Screen Saver (page 44).

Switch User
Starts a second session with a graphical user interface on your machine. Your current
session remains active while you are taken to the login screen where you can log
in as a different user. You can access the first session again by pressing Ctrl + Alt
+ F7. To access a new session, press F8 instead of F7. Additional sessions can be
accessed by pressing Ctrl + Alt + F9 to F12.

If more than one desktop environment is installed on your system, you can also
choose to switch to another desktop for the new session as described in Section 1.4,
“Switching Desktops” (page 13).

Hibernate
This menu item is only available if your computer provides power management
functionality. Pauses your computer without logging you out. All your data and
the session data is saved to disk before the system is laid to rest. It is thus protected
against data loss should you loose power in the meantime. Waking the system up
again is much faster than booting it from scratch.

Sleep
This menu item is only available if your computer provides power management
functionality. Pauses your computer without logging you out. All your data and
the session data is saved to RAM. Bringing the system up again is faster than
restoring a session from disk.

Shutdown Computer
Logs you out and turns your computer off.
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Restart Computer
Initiates the shutdown process and reboots your computer. Instead of selecting the
desired boot option in the boot manager, you can also select the desired option di-
rectly—just click one of the option below Restart Computer.

To access most of the options for leaving, you can also use the keyboard shortcut defined
in the Personal Settings. Usually, this is Ctrl + Alt + L.

TIP: Looking Up KDE Keyboard Shortcuts

If you are interested in other KDE keyboard shortcuts, look them up in the KDE
4 Personal Settings, described in Chapter 3, Customizing Your Settings (page 37).
For a description of how to change KDE keyboard shortcuts, refer to Modifying
KDE Keyboard Shortcuts (page 48).

If you have already logged out, you can still access shutdown and restart option from
the login screen by clicking System and selecting the respective menu items.

1.4 Switching Desktops
If more than one desktop environment is installed on your system (for example, KDE
and GNOME, or KDE 3.5.x and KDE 4), you can choose to switch to another desktop
when logging in again (or when logging in as a different user). To do so, proceed as
follows:

1 On the login screen, click Session Type and select the desktop environment to
start.

2 Enter a valid username and password. A new session on the selected desktop
environment starts.

3 To switch back again, log out from the current desktop and select a different
Session Type on the login screen. If you do not select a new session type, your
next session will be of the same type as the session before.

Getting Started with the KDE Desktop 13





2Working with Your Desktop
After having being introduced to the desktop, you can now start to work with your
desktop.

2.1 Starting Programs
You can start programs either from the main menu or from the command line, using
the Run Command dialog or a shell. Additionally, you can start programs from the
desktop or the panel by left-clicking the respective program icon once.

TIP: Selecting and Starting Objects

Clicking an object once in openSUSE usually starts an action directly: a program
starts, a preview of the file is displayed, or the folder is opened. To former
users of Windows, this behavior may be rather unusual. If you just want to select
one or several objects without any other action, press Ctrl then click the object.
Alternatively, alter your mouse settings in the KDE Personal Settings as described
in Adjusting the Mouse Settings (page 47).

2.1.1 Using the Main Menu
To open the main menu, click the main menu icon in the panel or press Alt + F1. The
main menu consists of the following elements: a search function at the top and several
tabs at the bottom, providing quick access to the key functions of the menu.
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The following tabs are available:

Favorites
Shows a default selection of key programs for quick access.

Applications
Shows all applications installed on your system. The function-oriented menu
structure makes it easy to find the right application for your purpose even if you
do not know the application names yet. To navigate through the structure, click an
entry and use the arrow icons at the right or the left to switch back and forth. To
switch back to the top-level hierarchy from anywhere in the structure, just click
the tab's name or icon.

Computer
Gives quick access to some places often needed, such as important system folders
(home directory, network folders) and media devices. Also allows you to quickly
access system information and to change your system configuration with YaST, if
necessary.
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Recently Used
Lists the most recently opened programs and files. To reopen a program or file,
just click the entry. To remove all recently used programs or files from the list,
right-click below the respective heading and selectClear Recently Used Applications
or Clear Recently Used Documents.

Leave
Shows several options for leaving the session such as logging out, locking the
screen (access can only be regained with a password), shutting down or restarting
the computer. For more information, see Section 1.3, “Leaving Your System”
(page 11).

Additionally the menu displays your login name and the hostname of your computer.
This information is useful when you are logged in as a different user or on a remote
computer—it always shows you which system you are currently working on.

2.1.2 Using the Run Command Dialog
KRunner is a helper application with lets you quickly start programs. Apart from that,
it offers a search function for finding applications or locations. Refer to Section 2.1.3,
“Searching for Programs” (page 18) for more information.

Press Alt + F2 to open the Run Command dialog. Type a command, for example,
dolphin, and press Enter or click Launch to start the application. The command to
start the application is often (but not always) the application name written in lowercase.
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If you want to start an application as a different user (for example, as root), click the
wrench icon in the Run Command dialog. Activate Run as Different User, enter the
user's password and press Enter.

The Run Command dialog also allows you to use the so-called Web shortcuts defined
in Konqueror. With these, you can send search requests directly to a search engine like
Google*, without opening the browser and visiting the Web sites before. For more in-
formation, refer to Section “Using Web Shortcuts” (Chapter 16, Browsing with Kon-
queror, ↑Application Guide).

Click the wrench symbol to explore the full range of KRunner's abilities: For example,
if the Contacts plug-in is activated, just enter the name of one of your contacts and then
press Enter to open KMail and to start typing your mail.

If the respective plug-in is activated, you can also use KRunner as calculator or to
convert units.

2.1.3 Searching for Programs
Both the main menu and the Run Command dialog offer a search function that lets you
quickly start programs even if you do not know the exact application name or command
yet. To search for an application, start typing a command or part of the application
name in the main menu Search field of the menu or the input field in the Run Command
dialog. Each character you enter narrows down the search.
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From the list below the input field, choose the application or object matching your
query.

2.2 Using Dolphin File Manager
With KDE 4, Dolphin has replaced Konqueror as the default file manager, while Kon-
queror remains the default Web browser. For more information about Konqueror as
Web browser, see Chapter 16, Browsing with Konqueror (↑Application Guide). To start
Dolphin, click the card box icon in the panel or press Alt + F2 and enter dolphin.

2.2.1 Dolphin Main Window
The Dolphin main window consists of the following elements:

Menu Bar: The menu bar holds menu items for actions like copying, moving, or
deleting files, changing views, starting additional tools, defining your settings, and
getting help.
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Toolbar: The toolbar provides quick access to frequently used functions that can
also be accessed via the menu. If you hover the mouse pointer over an icon, a short
description is displayed.

Location Bar: The location bar displays the path to the current directory. It is
available in two versions: one shows the path to the current directory with icons for
every superordinate folder in a “bread crumb” view. Click any icon in the bread crumb
view to change to that directory. The second version of the location bar shows the path
to the current directory as a string of text you can edit.

Panels: By default, Dolphin shows only the Places panel on the left. It allows quick
access to some often used places like your home directory, the /root directory of the
file system, the trash bin, or removable media. There are several other panels you can
add to the main window.

Display Field (Working Space): The display field shows the contents of the selected
directory or file. By default, Dolphin displays the contents of your home directory on
start-up. Clicking a folder or file in Dolphin directly starts an action: Dolphin loads the
file into an application for further processing or opens the folder.

Status Bar: Shows the file type and size of the currently selected object and the
available disk space .

2.2.2 Managing Files and Folders
To perform actions like copying, moving, creating or deleting files, you need appropriate
permissions to the folders and files involved in your action.

Procedure 2.1 Copying, Moving, or Delete Files or Folders

1 In order to select one or multiple files and folders in Dolphin, move your mouse
pointer over the file or folder but do not click. A green cross appears on the upper-
left edge. To select the file or folder now, click the green cross icon. Alternatively,
press Ctrl and click the file or files. To deselect again, click the red minus icon
that appears if the object is currently selected.

2 Right-click and select Copy or Cut from the context menu.

3 Navigate to the destination folder in which to insert the object.
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4 To create a new folder at the current location, select File > Create New > Folder
or press F10. Enter a folder name in the new window and press Enter.

5 To insert the object you copied or cut in Step 2 (page 20), right-click the desti-
nation folder in the main display field and select Paste. The object is copied or
moved there.

6 To delete a file or folder, right-click the object in the main display field and select
Move to Trash from the context menu. The object is moved to the trash bin. From
there, you can restore it if necessary or delete the object irretrievably.

To quickly filter for certain filenames in the current directory, press Ctrl + I or select
Tools > Show Filter Bar to add the Filter input field to the bottom of the Dolphin main
window. Type any part of the filename you are searching for to see all files in the current
directory containing the search string. For more detailed and advanced searches, press
Ctrl + F to use KFind. For more information, refer to Section 2.4, “Finding Data on
your Computer or in the File System” (page 25).

2.2.3 Configuring Dolphin
Dolphin offers many options to adjust the view and the overall settings according to
your needs and wishes.

Procedure 2.2 Changing the View

1 To toggle between the bread crumb view and the editable version of the location
bar, press Ctrl + L or click at the far right end of the location bar. Enter a path to
a directory by typing it in. After typing an address, press Enter.

To delete the contents of the location bar click the black X symbol on the left.
To switch back to the bread crumb view, press Ctrl + L.

2 To change the view of the currently displayed folder, either click Icons, Details,
or Columns in the toolbar. Dolphin remembers the selected view for each folder.
Alternatively, press Ctrl + 1, Ctrl + 2, or Ctrl + 3 to switch between the view
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modes. Click Split or press F3 to view the contents of the current folder in two
separate columns. Now you can navigate to a different directory in each column
and easily drag or drop objects or compare the contents of directories.

3 To make Dolphin also show hidden files, select View > Show Hidden Files or
press Alt + +.

4 To viewmore details about the files (like access permissions or ownership), select
View > Additional Information and enable the respective options.
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5 To add further directories to the Places panel, drag a folder from the working
space to the Places panel and drop it there. Right-click and use the context menu
to hide, edit or remove entries from Places.

6 If you want to add more panels to the main window, select View > Panels and
select additional panels such as Information, Folders, or Terminal.

• The Information panel shows the properties and a preview of the currently
selected file. It also lets you add comments to the file.

• The Folder panel shows a tree view of the whole file system and lets you
navigate trough all subdirectories of /root.

• The Terminal panel attaches a command line to the bottom of the main
Dolphin window. Whenever you click a directory in the display field, the
Terminal panel also changes to the according directory, so you can easily
switch to the command line for certain tasks you prefer to execute in a shell.

You can even detach the panels from the main Dolphin window by clicking the left
icon at the top of each panel. Click the panel's title bar and drag it to another place on
the desktop. To reintegrate the panel into the Dolphin window again, click the left
symbol at the top of the panel again.
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Procedure 2.3 Changing Dolphin's Overall Behavior

If you want to change Dolphin's overall behavior or view, select Settings > Configure
Dolphin and explore the options offered in the Dolphin configuration dialog.

1 To use the same view mode for all folders, click View Modes in the left sidebar.
ActivateUse Common View Properties for All Folders on theGeneral tab. Adjust
the options for the individual view modes on the other tabs according to your
wishes and click Apply to save the changes.

2 If you want Dolphin to show a different default directory on start-up, or if you
want to permanently use the editable location bar instead of the bread crumb
view, change the according options on the General tab.

3 Click OK to save the changes and to close the Dolphin configuration dialog.

2.3 Moving Text between Applications
To copy text to the clipboard and insert it again, former MS Windows users automati-
cally try the keyboard shortcut Ctrl + C and Ctrl + V, which often works in Linux as
well. Copying and inserting texts is even easier in Linux: to copy a text to the clipboard,
just select the text with the mouse then move the mouse cursor to the position to which
to insert the text. Click the middle button on the mouse to insert the text (on a two-
button mouse, press both mouse buttons simultaneously).

With some applications, if a text is already selected in the application where you want
to insert the text, this method does not work because the text in the clipboard is over-
written by the other selected text. For such cases, the KDE application Klipper is very
useful. Klipper “remembers” the last entries you havemoved to the clipboard. By default,
Klipper is started when KDE is loaded and appears as a clipboard icon in the panel. To
view the clipboard contents, click the Klipper icon or press Ctrl + Alt + V. The most
recent entry is listed on top and is marked as active with a black check mark. If an ex-
tensive text was copied to Klipper, only the first line of the text is displayed.

To copy an older text fragment from Klipper to an application, select it by clicking it,
move the mouse pointer to the target application, then middle-click. For further infor-
mation about Klipper, see the Klipper online help.
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2.4 Finding Data on your Computer
or in the File System

KDE provides more than one application for finding data on your computer or in the
file system. With Kerry, you can very easily search your personal information space
(usually your home folder) to find documents, e-mails, Web history, IM/ITC conversa-
tions, source code, images, music files, applications, and much more. For more infor-
mation, refer to Chapter 6, Searching with Kerry (page 73).

With KFind, you can locate files on your computer or in the file system using a variety
of search criteria, such as file content, dates, owner, or file size. Start it from the main
menu with Applications > Find Files/Folders. Alternatively, press Alt + F2 and enter
kfind.

Figure 2.1 Finding Files with KFind

2.4.1 Finding Files
To perform a search for certain filenames, proceed as follows:

1 Start KFind from the main menu or command line.

2 Click the Name/Location tab to perform a basic search.
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3 Specify the name of the file to find in Named. You can use the following wild
cards:

Asterisk
The asterisk (*) stands for any number of missing characters (even zero).
For example, searching for marc* can find the files marc, marc.png, and
marc_must_not_read_this.kwd. Searching for mar*.kwd can find market-
place.kwd and marc_must_not_read_this.kwd.

Question Mark
The question mark (?) stands for exactly one character. For example,
searching for mar? can find marc, but marc? cannot find anything if your
files are named marc and marc.png. You can put as many question marks
in the search term as you want. It finds exactly that number of characters.

You can combine those two wild card symbols in any search term.

4 Specify the folder to search in Look In or click Browse to find the folder you
want. Select Include Subfolders to also search all subfolders starting from your
specified folder.

5 Press Enter or click Find.

2.4.2 Performing an Advanced File Search
For a more detailed search, you can also specify further options, such as a text the file
to find must contain:

1 Start KFind from the main menu or the command line.

2 Click the Name/Location tab.

3 Specify the name of the file to find in Named.

4 Specify the folder in which to search in Look In or click Browse to find the
folder.

5 Click the Contents tab.
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6 In File Type, specify the type of file to find.

7 In Containing Text, enter the word or phrase the file you are searching for must
contain.

8 If you want to specify further options, click the Properties tab and choose the
options you want.

9 Click Find to perform the search.

For detailed information about the search options available, refer to the KFind online
help.

2.5 Accessing Removable Media and
External Devices

If you insert removable media (such as CDs or DVDs) in your computer's drive, or
connect external devices such as USB sticks, external hard disks, media players or
digital cameras, these are usually automatically detected. In KDE 4, a panel widget in-
forms you about recently plugged or inserted devices.

Figure 2.2 Device Notifier

Click on the entry to show the device's contents with Dolphin.
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If the device is not automatically displayed in the device notifier, try to access it manu-
ally with Dolphin.

Start Dolphin file manager and switch to the editable version of the location bar as de-
scribed in Changing the View (page 21). Enter /media to access any type of drive
mounted there. If the medium has been detected, it is also listed in the Places panel.
Click the respective entry to show the contents. Digital cameras can also be accessed
by entering the URL camera:/ into Dolphin's location bar. In case your camera is
not automatically detected, configure it first with the KDE 4 Personal Settings or with
digiKam as described in Section “Configuring Your Camera” (Chapter 20, Managing
Your Digital Image Collection with DigiKam, ↑Application Guide). Navigate through
the camera's directory structure until the files are shown. Use the usual Dolphin file
management features to copy the files as desired.

Another way to access detectedmedia is to click theMyComputer icon on your desktop.
The detected devices are listed in the Disk Information section.

NOTE: Removing Media Safely

If you want to remove or disconnect a medium from your computer, make
sure that the data on the medium is currently not accessed by any application
or user. Otherwise, you risk a loss of data. To safely remove the medium, pro-
ceed as follows:

1. Open a view that displays the removable medium (for example, with Dol-
phin or My Computer).

2. Right-click the medium in the Places panel (or below Disk Information)
and select Safely Remove or Eject. Safely Remove unmounts the medium
after which you can disconnect the medium from your computer. Eject
automatically opens the CD or DVD drive of your computer.

2.6 Using Virtual Desktops
The desktop environment allows you to organize your programs and tasks on several
virtual desktops between which you can switch the pager in the panel (see Section 1.2,
“Exploring the Desktop Components” (page 5)). If you often run a lot of programs
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simultaneously, this minimizes the number of windows to arrange on your screen. You
might, for example, use one desktop for e-mailing and calendaring and another for word
processing or graphics applications.

Procedure 2.4 Moving an Application to Another Virtual Desktop

You can display a running application on one or all virtual desktops or move it to
other desktops.

1 Open the application.

2 Right-click the title bar of the application.

3 Click To Desktop.

4 Select the desktop on which to place the application.

5 To switch between desktops, click the desired desktop in the pager in the panel.

Some users might need more desktops than provided by default. Learn how to add ad-
ditional desktops in Adding Additional Virtual Desktops (page 45).

2.7 Managing Internet Connections
To surf the Internet or send and receive e-mail messages or use Instant Messengers,
you must have configured an Internet connection with YaST or NetworkManager. For
more details, see Section “Configuring a Network Connection with YaST” (Chapter 19,
Basic Networking, ↑Reference) and Chapter 10, Using NetworkManager (↑Start-Up).

2.8 Exploring the Internet
When an Internet connection is established, either use Konqueror or Firefox for
browsing. Konqueror is KDE's default Web browser but openSUSE also includes
Firefox. To start Konqueror or Firefox, press Alt + F2 and enter konqueror or
firefox.
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With features like tabbed browsing, pop-up window blocking, and download and image
management, both browsers combine the latest Web technologies. Their easy access
to different search engines helps you to find the information you need.

For more information about Firefox, see Chapter 17, Browsing with Firefox (↑Applica-
tion Guide). Learn more about Konqueror as a Web browser in Chapter 16, Browsing
with Konqueror (↑Application Guide).

2.9 E-Mail and Scheduling
For reading and managing your mails and appointments, you can use Kontact as your
personal information management tool (PIM). Kontact combines KDE applications
like KMail, KOrganizer, and KAddressBook into a single interface. This gives you
easy access to your e-mail, calendar, address book, and other PIM functionality. KMail
can also managemultiple e-mail accounts, such as your private e-mail and your business
ones. To start Kontact, press Alt + F2 and enter kontact.

Before you can send or receive mails, you must configure an e-mail account. When
starting KMail for the first time, a configuration wizard appears that assists you in setting
up your account. For detailed information about configuring and using Kontact, see
Chapter 5, Kontact: E-Mailing and Calendaring (↑Application Guide).

2.10 Instant Messaging
Kopete is an online messenger application that allows multiple partners connected to
the Internet to chat with each other. Kopete currently supports a number of common
messenger protocols. To be able to use instant messaging (IM), you must register with
a provider offering IM services and configure a Kopete account.

To start Kopete, press Alt + F2 and enter kopete. Learn more about Kopete in Chap-
ter 13, Instant Messaging with Kopete (↑Application Guide).
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2.11 Managing Passwords
When you enter a password in a KDE application for the first time (in KMail or Kon-
queror, for example), you are asked if you want to store the password in an encrypted
wallet. If you click Yes, KWallet wizard starts by default. KWallet is a password man-
agement tool that can collect all passwords and store them in an encrypted file. For
more information on how to configure and use KWallet, refer to Chapter 8,Managing
Passwords with KWallet Manager (page 81).

Whereas KWallet is designed to centrally manage passwords for several KDE applica-
tions, Firefox also offers the ability to store data when you enter a username and a
password on a Web site. If you accept by clicking Remember, the password will be
stored on your hard disk in an encrypted format. Next time you access this site, Firefox
will automatically fill in the login data.

To review or manage your passwords in Firefox, click Edit > Preferences > Security
> Saved Passwords....

2.12 Opening or Creating Documents
with OpenOffice.org

The office suite OpenOffice.org offers a complete set of office tools including a word
processor, spreadsheet, presentation, vector drawing, and database components. Because
OpenOffice.org is available for a number of operating systems, you can use the same
data across different computing platforms. You can also open and edit files inMicrosoft
Office formats then save them back to this format, if needed.

Start OpenOffice.org from the main menu or click the Office icon on the desktop. You
can also start individual components, like the word processor, by pressing Alt + F2 and
entering oowriter.

For an introduction to OpenOffice.org, see Chapter 1, The OpenOffice.org Office Suite
(↑Application Guide) or view the help in an OpenOffice.org program.
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2.13 Viewing PDF Files and Other
Documents

Documents that need to be shared or printed across platforms can be saved as PDF
(Portable Document Format) files, for example, in the OpenOffice.org suite. View them
with Okular, the default KDE document viewer.

Start Okular from the main menu or press Alt + F2 and enter okular.

To open a document, select File >Open and choose the desired file from the file system.
Navigate through the documents by using the navigation icons at the top or bottom of
the window. If your PDF document provides bookmarks, you can access them in the
left panel of the viewer.

Okular also allows you to review a document by highlighting certain text parts or adding
annotations. For more information about working with Okular, see Chapter 4, Viewing
PDF Files and Other Documents with Okular (page 59).

Alternatively, you can also view PDF files with Adobe Acrobat Reader. If Acrobat
Reader is not installed by default, install the acroread package with YaST. To start
Acrobat reader, press Alt + F2 and enter acroread or start the program from the main
menu. Click File > Open, locate the desired PDF file and click Open to view the file.

2.14 Taking Screen Shots
With KSnapshot, you can create snapshots of your screen or individual application
windows. Start the program from the main menu or by pressing Alt + F2 and entering
ksnapshot. On start-up, KSnapshot already takes a snapshot of the screen and displays
it as preview. You can choose to save the current snapshot, to open it with an graphics
application or to copy it to the clipboard. Before creating a new snapshot, check if the
options in the lower part of the windowmatch your needs. For example, to automatically
capture a dialog window or a certain region (instead of the full screen), adjust the
CaptureMode. If you need to take some other actions first (like selecting a certain object
in the window), adjust the Snapshot Delay and choose if to Include the window decora-
tions or not. Then click New Snapshot to take a new snapshot which you then can save
or edit further.
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Figure 2.3 KSnapshot

2.15 Displaying, Decompressing, and
Creating Archives

To save space on the hard disk, use a packer that compresses files and directories to a
fraction of their original size. The application Ark can be used to manage such archives.
It supports common formats, such as zip, tar.gz, tar.bz2, lha, and rar.

Start Ark from the main menu or from the command line with ark.

Figure 2.4 Ark: File Archive Preview

Once you have opened an archive, perform various actions. Action offers options such
as Add File, Add Folder, Delete, Extract, View, Edit With, and Open With.
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Procedure 2.5 Creating an Archive

1 To create a new archive, select File > New.

2 Enter the name of the new archive in the dialog that opens and specify the format
using Filter.

After confirming with Save or by pressing Enter, the Ark window shows an
empty archive.

3 To fill the archive, drag and drop files and directories from the file manager into
this window or click Add File or Add Folder to add the objects you want to add
to the archive.

4 To remove a file from the archive, select the file and click Delete.

5 If all files to be archived are displayed in the window, just close Ark. Ark auto-
matically compresses everything into the previously selected archive format and
saves the archive.

Procedure 2.6 Viewing and Extracting Archives

1 To view the contents of an archive, start Ark and select File > Opento open the
file. Alternatively, just drag the archive from an open file manager window to
the Ark window.

2 To see a preview of individual files, select a file and click Preview.

3 To extract all files from the archive, click Extract.

If you want to extract individual files from the archive only, select one or more
files (by keeping the Ctrl key pressed) and click Extract. In the following dialog,
you can still decide to save All Files or the Selected Files Only.

4 Enter the path to the Destination Folder, select if to Open Destination Folder
After Extraction and click OK to extract the files.
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2.16 Creating CDs or DVDs
If you possess a CD or DVD writer, you can burn files to a CD or DVD with K3b. To
start K3b, press Alt + F2 and enter k3b. Learn more about K3b in Chapter 25, Burning
CDs and DVDs With K3b (↑Application Guide).

2.17 Viewing and Managing Digital
Images

You can view digital images in the file manager or with Gwenview. Start Gwenview
by pressing Alt + F2 and entering gwenview. Gwenview can load and save all image
formats supported by KDE. It shows them either as thumbnails, in full screen view, or
in slide show mode. When browsing JPEG images with EXIF information, Gwenview
automatically rotates them according to the EXIF Orientation tag.

For managing and editing your digital images, digiKam is the right choice: download
your images from the camera, edit and improve them, organize them in albums (or flag
them with tags for easy retrieval, independent of folders or albums), and archive them
on CD or export them to a Web image gallery.

To start digiKam, press Alt + F2 and enter digikam. Find an introduction to digiKam
in Chapter 20, Managing Your Digital Image Collection with DigiKam (↑Application
Guide).

2.18 Managing Your Music Collection
KDE's amaroK music player allows you to play various audio formats, create playlists,
import music from an iPod* (or upload files to your iPod), and listen to streaming audio
broadcasts of radio stations on the Internet. The file types supported depend on the engine
used for amaroK. To start amaroK, press Alt + F2 and enter amarok. On first start,
amaroK launches a First-Run Wizard with which to define the folders where amaroK
should look for your music files. For more information about amaroK, refer to Chap-
ter 22, Playing Music and Movies: amaroK, Kaffeine and More (↑Application Guide).
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2.19 For More Information
As well as the applications described here for getting started, KDE can run a lot of
other applications. Find detailed information about many important applications in the
other parts of this manual.

• To learnmore about KDE andKDE applications, also refer to http://www.kde
.org/ and http://www.kde-apps.org/.

• Communicate and discuss topics with other KDE users and get help at http://
forum.kde.org/index.php.

• To learnmore about the helper applications included in the KDE, see also http://
utils.kde.org/.

• To report bugs or add feature requests, go to http://bugs.kde.org/.
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3Customizing Your Settings
You can change the way your KDE desktop looks and behaves to suit your own personal
tastes and needs. There are several ways to influence the look and feel of the KDE
desktop depending on the scope of changes to make. For users, the following options
are available:

• To change the appearance or behavior of individual desktop objects only, you can
usually access a configuration dialog by right-clicking the object.

• To change the overall appearance and behavior of your KDE desktop, use the
Personal Settings that in KDE 4 replace the former KDE Control Center. The Per-
sonal Settings offer access to numerous configuration modules and dialogs, some
of which can also be accessed via the context menu of individual desktop objects.

3.1 The Personal Settings
The Personal Settings are the central place for users to change the overall appearance
and behavior of many components of the KDE desktop. Start the Personal Settings from
the main menu by selecting Favorites > Configure Desktop.
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Figure 3.1 Personal Settings

TIP: Starting Individual Modules

You can also start individual modules of the Personal Settings from the shell
or by adding a special applet to your panel.

To start modules from a shell, enter kcmshell4 --list to get a list of all
modules available. Then enter kcmshell4 module name to start the desired
module.

Alternatively, add the Settings applet to your panel according to the description
in Section 3.3, “Configuring the Panel” (page 46).

The General and Advanced tabs provide different categories of settings. To get an im-
pression of the numerous possibilities, just click a category icon and explore the possi-
bilities provided there. Performing tasks in some areas of the personal settings requires
system administrator (root) permissions.
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Change the settings as desired. No changes take effect until you click Apply. To discard
changes in the recent view that you have not yet applied, click Reset. To reset all items
in the recent view to the default values, click Defaults.

To get back to the start-up view showing all categories again, click Overview. You can
also enter a search string at the top of the window (for example, Screen Saver) to find
the category which holds options related to the search string. Each character you enter
in the Search field narrows down the search.

The following list introduces the major categories and highlights the most important
settings you can change there. Detailed information about the settings of each category
is provided by the Help button on each page of the settings or in the help center.

The General tab holds the following categories:

Look & Feel
Holds settings for the appearance of your KDE 4 desktop, such as themes, window
decorations, and styles of desktop elements. Allows you to configure 3D desktops
effects, increase or decrease the number of virtual (multiple) desktops, or to config-
ure screen saver options. Cursor behavior, window behavior and the splash screen
that appears on KDE start-up can also be influenced here.

Personal
Holds settings for changing the default paths to some important directories for your
data:Desktop, Autostart, andDocuments. Allows you to change the default
applications like e-mail client, text editor, messenger, and Web browser that are
called whenever a KDE application needs to start an application of these types.
Define country and language-specific options here, such as default spell checking
options, currency, number and date format, and keyboard layouts for different
languages between which you can switch. This category also offers accessibility
options for handicapped users, such as sound and keyboard options and mouse
gestures.

Network & Connectivity
Allows you to set options for local network browsing and proxy servers.
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Computer Administration
Allows you to configure date and time settings for your KDE desktop, to change
size and orientation of your display, and to specify power management options for
saving energy. Also holds settings for joysticks, keyboard and mouse. For example,
you can view and modify the predefined KDE shortcuts (for example, Alt + Ctrl +
L to lock the screen). You can also install personal or systemwide fonts here and
configure your sound system.

On the Advanced tab, find the following categories:

Advanced User Settings
Use this category to configure options like encoding or which database to connect
for track listings of audio CDs, to configure your digital camera, or to change the
settings for KWallet (the KDE password management tool). If needed, change the
default file associations to identify a file type and start an appropriate application.
Define howKDE handles sessions on login or shutdown and define which applica-
tions should be started automatically.

System
Hold option for the login manager, power management and Samba.

In the following sections, find examples of how to configure some aspects of your KDE
desktop that you might want to customize.

3.2 Configuring Desktop Objects
Your KDE desktop comes with a predefined set of desktop icons. By adding various
objects such as folders, files, or widgets, you can create additional icons on your desktop
and arrange them as you like.

Procedure 3.1 Adding Program Icons to the Desktop

To create a link to an application and place it on the desktop or the panel, proceed as
follows:

1 Click the main menu button and browse to the desired application.

2 Right-click and select Add to Desktop or Add to Panel from the context menu
that appears. If these menu items are not available, your desktop elements are
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probably locked. Unlock them first as described in Section 1.2.1, “Locking and
Unlocking Desktop Objects” (page 7).

If your desktop objects are not locked, you can also just drag items from the main
menu onto the desktop and drop them there to create a link to this application or
folder.

3 To change the icon position on the desktop, left-click the icon and drag it to the
desired place.

To delete an icon from your desktop, right-click the icon icon and select Remove this
Icon.

Procedure 3.2 Adding Widgets to the Desktop

Widgets are small applications that can be integrated into your desktop or your panel.

1 To add widgets to you desktop, right-click an empty patch on your desktop and
select Add Widgets.

If these menu items are not available, your desktop elements are probably locked.
Unlock them first as described in Section 1.2.1, “Locking and Unlocking Desktop
Objects” (page 7).

2 In the dialog box that appears, you can limit the selection of widgets that is shown
with the drop-down list at the top.
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3 Select a widget and click Add Widget. The widget appears on your desktop or in
your panel.

4 To position the widget on your desktop, left-click the widget and drag it to the
desired place. To align all widgets to a grid, right-click an empty patch on the
desktop and select Align Horizontally or Align Vertically.

To remove a widget from your desktop, right-click the widget and select the Remove...
entry. Alternatively, hover your mouse pointer over the widget and click the X symbol
in the frame.

Procedure 3.3 Configuring Widgets

In order to configure widgets, the desktop elements need to be unlocked as described
in Section 1.2.1, “Locking and Unlocking Desktop Objects” (page 7).

1 To configure a widget, hover your mouse pointer over the widget until a
translucent frame appears around the widget, showing a number of symbols.

If the frame does not appear, your widgets are probably locked. Unlock them
first as described in Section 1.2.1, “Locking and Unlocking Desktop Objects”
(page 7)

2 To change the widget size, left-click the resize symbol in the frame and keep the
mouse button pressed while moving your cursor across the desktop to scale the
widget size.

3 To rotate the widget in any direction, left-click the arrow symbol in the frame
and keep the mouse button pressed while moving your cursor in a circle across
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the desktop. There is a sticky boundary in the horizontal and vertical positions
where you can “clamp” the widget, if you like. Of course, you can also arrange
it in any tilted position.

4 To change the contents, settings, or properties of a widget, left-click the wrench
symbol in the frame. In the configuration dialog box that appears, set the options
according to your wishes.

Use the X symbol in the frame if you want to close the widget.

Procedure 3.4 Changing the Desktop Background

You can change the background colors of your desktop or select a picture to use as
the background.

1 Right-click an empty patch of the desktop and select Desktop Settings. A confi-
guration dialog appears.

2 In theWallpaper section, choose from the Type drop-down list if you want to
use an Image, a Slide Show or a Color as background.
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• For an image wallpaper, choose a wallpaper from the Picture list. Click Get
New Wallpapers to download and install new wallpapers. To use a custom
picture, click the folder button beneath the list and select an image file from
the file system. Define the Positioning of the image.

• To have multiple images appear in a Slide Show mode, define the directory
from which to select the pictures and set the interval after which to change
the images.

3 Set the other options in the configuration dialog according to your wishes and
click OK to save your changes and leave the configuration dialog.

Procedure 3.5 Configuring the Screen Saver

openSUSE® comes with predefined screen saver settings that you can adjust.

1 Start the Personal Settings from themainmenu by selectingFavorites >Configure
Desktop.

2 On the General tab, select Desktop.

3 In the dialog that opens, click Screen Saver.

4 In the list of screen savers, click a screen saver to see a preview in the right side
of the dialog.
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5 Click Setup to adjust options like speed or shapes.

6 You can also choose to view a blank screen instead or to let KDE start a random
screen saver. Find these options at the end of the screen saver list.

7 Under Settings, determine after how long a time of inactivity the screen saver
should start and whether a password is required to unlock the screen after the
screen saver has started.

8 Click OK to apply the changes and close the configuration dialog.

Procedure 3.6 Adding Additional Virtual Desktops

Some users might need more desktops than provided by default.

1 Right-click the desktop previewer in the panel and select Configure Desktops.
A configuration dialog appears where you can increase or reduce the number of
virtual desktops. You can also change the default names of the desktop.

2 Click OK to apply the changes and close the configuration dialog.
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3 For the names of the desktops to appear in the desktop previewer rather than the
number, right-click the desktop previewer and select Pager Options > Desktop
Name.

3.3 Configuring the Panel
You can customize the KDE panel according to your preferences: Applications and
widgets can be added to the quick launch area or the system tray in the main panel or
to additional panels. Panel elements and additional panels can be moved to different
places or be completely removed at any time.

Procedure 3.7 Customizing the Panel

1 Right-click an empty patch in the panel and select Panel Settings to access
any panel configuration options. If the menu item is not available, your desktop
objects are probably locked. To unlock, right-click and selectUnlockWidgets.

2 To move panel objects to a different place within the panel, hover the mouse
cursor over the respective panel object (for example, program icon, pager,
task manager, system tray) . The mouse cursor turns into a crosslines-like
form. Move the cursor to the desired position in the panel, then click again to
fix the object in the new position.

3 To change the panel width, click and drag the small arrow icons at the far left
and right end of the settings panel.

4 To change the panel height, click theHeight button andmove the mouse cursor
to the desired end location.

5 To place the panel at different sides of the screen use the Screen Edge button.
Drag and drop the panel to the preferred location.

6 If you need additional widgets on your panel, add themwith the AddWidgets...
button as described in Step 2 (page 41).
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7 To remove program icons or widgets from the panel, right-click the respective
object and select the menu item to remove the icon or widget.

The icons in the system tray usually belong to applications running in the
background. Therefore you can only remove those icons if you close the re-
spective application (right-click the icon and select Quit).

8 To prevent the panel and widgets from being moved accidentally, use Lock
Widgets.

9 For additional configurations options like alignment and functions like auto
hide, clickMore Settings....

10 If all panel changes are according to your wishes, close the settings panel with
the red close button on the right side.

3.4 Configuring KDE Behavior
Procedure 3.8 Adjusting the Mouse Settings

1 Open the Personal Settings and select Keyboard & Mouse.
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2 To switch to double-clicks to open files and folders, select the corresponding
option in the Icons group.

3 To change the mouse pointer appearance, switch to the Cursor Theme tab and
select a different cursor theme.

4 To change the default values of double-click intervals or the distance that the
pointer moves over the screen on movement of the mouse, adjust the settings on
the Advanced tab.

5 Click Apply to apply the changes and close the configuration dialog.

Procedure 3.9 Modifying KDE Keyboard Shortcuts

KDE comes with a set of predefined keyboard shortcuts. You can easily create more
keyboard shortcuts or change existing shortcuts, especially if they should conflict
with other application-specific shortcuts.

1 Open the Personal Settings and select Keyboard & Mouse.

2 Click Keyboard Shortcuts.
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3 Select theKDEComponent for which to view or change the shortcuts. For exam-
ple, to change the shortcuts for switching between the virtual desktops, select
the KWin entry from the drop-down list. To change the shortcuts for locking the
screen or logging out, select the Run Command Interface entry.

4 Browse through the list of shortcuts for the selected entry. To filter for certain
keywords, enter a search string in the search field above.

5 To change or add a shortcut, select the respective list entry and in the dialog that
opens, select Custom.

6 Click the wrench icon to switch to the input mode.

7 Press the desired key or key combination. If this shortcut cannot be accepted or
in case of conflict with another existing shortcut, a notification shows. If your
input was successful, the new or modified shortcut appears in the list.

8 If you want to switch back to the default keyboard shortcut for the selected action,
just click the entry again and select Default.

9 To save the altered settings, click Apply. To reset all shortcuts to the default
values, click Defaults then Apply.

Procedure 3.10 Changing Default Applications

There are certain default applications defined in KDE: For example, when you click
a link to a Web page, KDE opens the Konqueror Web browser, when you click an e-
mail address, KMail starts.

1 To change this behavior and set your preferred Web browser or e-mail client as
default, open the Personal Settings and click Default Applications.

2 To change the Web browser:

2a In the list of components, selectWeb browser.

2b Select Open http and https URLs in the following browser and click the
browse button beneath.
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2c A dialog opens, showing the main menu structure. Select the Web browser
to set as default and clickOK. The component chooser now shows the select-
ed application in the display field.

3 To change the e-mail client:

3a In the list of components, select Email Client.

3b Select Use a different email client and click the browse button.

3c A dialog showing the main menu structure opens. Select the e-mail client to
set as default and clickOK. The component chooser now shows the selected
application in the display field.

4 If desired, change other default applications for KDE, like the application for the
terminal window or the instant messenger client.

5 When all options are set according to your wishes, click Apply.

Similar to setting the default Web browser or e-mail application, you can change file
associations in KDE. File associations determine which application should be used
to open a file, for example, if you want to start a file from Konqueror.

1 Open the Personal Settings, click the Advanced tab and select File Associations.
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2 To search for an extension, enter the extension in Find File Type or File Name
Pattern. Only file types with a matching file pattern appear in the list. For exam-
ple, to modify the application for *.png files, enter png in Find File Type or File
Name Pattern.

3 In the Known Types list, click the file type to open the setting dialog for this file
type. You can change the icon, the filename patterns, description, and the order
of the applications.

If your tool is not listed, click Add in Application Preference Order then select
the program for the file type.

To change the order of the list entries, click the program to move. Give it a
higher or lower priority by clickingMove Up or Move Down. The application
listed at the top is used by default when you click a file of this type.

4 When all options are set according to your wishes, click Apply.
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3.5 Configuring System and Security
Aspects

To adjust settings such as time and date format, number format, or currency, select the
desired country as the default country in KDE. If more than one system language is
installed on your computer, you can also select different languages in which KDE
should show the graphical user interface and application interfaces.

Procedure 3.11 Adjusting Regional Settings

To adjust settings such as time and date format, number format, or currency, select
the desired country as the default country in KDE. If more than one system language
is installed on your computer, you can also select different languages in which KDE
should show the graphical user interface and application interfaces.

1 To set your default country options, open the Personal Settings and selectRegional
& Accessibility.

2 On the Locale tab, clickChange next to theCountry or Region entry. In the dialog
that opens, select the region and country you want to set as default in KDE and
click OK.

Number, date and time format are automatically adjusted to the new country's
default values that are shown in the display field at the bottom of the Locale tab.
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3 If you need to make further adjustments for those, click the respective tabs and
set the options according to your wishes.

4 If more than one language is installed on your system (as secondary languages
with YaST) and you want to change the graphical interface of KDE to a different
language, click Add Language on the Locale tab. This opens a list of languages
currently installed on your system.

5 Select the language for the graphical user interface. The new language is now
shown at the top position in the Language list.

6 To confirm the changes, click Apply. All newly started applications or desktop
objects now appear in the new language.

7 To switch to another language, re-sort the languages in the Languages list until
the desired language is at the top position and apply your changes.

Procedure 3.12 Adding Keyboard Layouts

If you often need to enter texts in various languages, you may want to add different
language layouts for your keyboard. You can then easily switch layouts when needed.

1 To add additional keyboard layouts, open the Personal Settings and selectRegional
& Accessibility > Keyboard Layout.

2 Activate Enable keyboard layouts at the top.

3 In the list of Available layouts, select a layout. Click the right arrow button to
transfer it to the list of Active layouts.
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4 If you added several layouts, you can change the sorting order with the help of
the up and down arrow buttons.

5 Use the Switching Options tab to adjust the options for switching between the
keyboard layouts. For example, you can define keyboard shortcuts for switching.
After having confirmed your changes with Apply, you can change between dif-
ferent keyboard layouts by clicking the country flag in the panel or by using the
respective keyboard shortcut.

KDE runs a session manager that starts after your username and password are authenti-
cated by the login process. It lets you save the status of a certain session and return to
that status the next time you log in. For example, it can automatically start the applica-
tions that you were running in the most recent session or when you manually saved a
session. It can save and restore the following settings:

• Appearance and behavior settings, such as fonts, colors, and mouse settings.

• Applications that you were running, such as a file manager or OpenOffice.org.

NOTE: Saving and Restoring Applications

You cannot save and restore applications that Session Manager does not
manage. For example, if you start the vi editor from the command line in
a terminal window, Session Manager cannot restore your editing session.
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Procedure 3.13 Adjusting the Session Handling

1 To change the session handling options, open the Personal Settings and on the
Advanced tab, click Session Manager.

By default, Session Manager restores the applications that were running when
you logged out from the previous session, enabling an automatic start of these
applications.

2 To be able to save a certain session manually and restore this session each time
you log in to KDE, select Restore manually saved sessions. This adds a new
menu item, Save Session, to your main menu. After a session is saved, KDE au-
tomatically restores the saved session on each login.

3 To start with a “fresh” session each time you log in, select Start with an empty
session.

4 To change the default options that appear when logging out, adjust the respective
options in the General and Default Shutdown Options group.

5 Click Apply to confirm your changes.

Procedure 3.14 Starting Programs Automatically

Apart from the applications from the last session that are restored by the Session
Manager, you can configure which applications should be always be started after login.

1 Open the Personal Settings and on the Advanced tab, click Autostart.

2 To add an application, click Add Program and from the menu structure, select
the program you want to start automatically.

To add a shell script, click Add Script and click the Open File Dialog icon in the
next window to select the script from the file system. The program or script is
added to the list and you can view and change the Status.
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3 Click Apply to confirm your changes. When logging in the next time, the appli-
cations and scripts should start automatically.
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Part II. Managing Files and
Resources





4Viewing PDF Files and Other
Documents with Okular
Apart from PDF files, Okular allows you to view a great number of file formats, such
as PostScript, several image formats, OpenDocument format (ODF), OpenDocument
text (ODT), some eBook formats (ePub), and even Microsoft* Compiled HTML Help
(CHM). Okular also provides support for bookmarks, annotations, form fields and
multi- media contents, and rotation of pages.

4.1 Viewing PDF Files
Documents that need to be shared or printed across platforms can be saved as PDF
(Portable Document Format) files, for example, in the OpenOffice.org suite. View them
with Okular, the default KDE document viewer.

Start Okular from the main menu or press Alt + F2 and enter okular. To open a doc-
ument, select File > Open and choose the desired file from the file system. Navigate
through the document by using the navigation icons at the top or bottom of the window.
Depending on which icon you click on the navigation panel on the left, the sidebar either
shows a table of Contents, a Thumbnail view of each page, the Reviews for this file,
or your Bookmarks for this file. To filter for any text listed in the sidebar or the overall
document, enter a string into the input field at the top of the sidebar. If you want to select
and copy text or images from the file in Okular, click the Selection icon in the toolbar
and select one of the options from the context menu. Click the Browse icon to switch
back to browsing the document. Working with Bookmarks and Annotations With
Okular, you can review a document by highlighting certain text parts or adding annota-
tions or bookmarks that Okular then attaches to the file in form of metadata. Note that
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the annotations and markers you add are not stored within the document, so you cannot
print them or pass them on to other users.

Figure 4.1 Okular Viewing a PDF File

4.2 Annotating a PDF File
With Okular, you can review a document by highlighting certain text parts or adding
annotations or bookmarks that Okular then attaches to the file in form of metadata.
Note that the annotations and markers you add are not stored within the document, so
you cannot print them or pass them on to other users.

To create an annotation for a page, press F6 and select one of the annotation tools from
the toolbar that appears. The annotation is added to the list of Reviews and is flagged
with the login name of the user who created it. Use the icons at the bottom of the sidebar
to group the annotations by page, by author or to show the annotations for the current
page only.
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Figure 4.2 Annotating a PDF File

4.3 For More Information
See the homepagehttp://okular.kde.org of Okular for more information. The
supported formats can be viewed at http://okular.kde.org/formats.php.
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5Accessing Network Resources
From your desktop, you can access files and directories or certain services on remote
hosts or make your own files and directories available to other users in your network.
openSUSE® offers various different ways of accessing and creating network shared
resources:

Network Browsing
Your file managers, Dolphin or Konqueror, let you browse your network for shared
resources and services. Learn more about this in Section 5.2, “Accessing Network
Shares” (page 64).

Sharing Folders in Mixed Environments
Using Dolphin or Konqueror, configure your files and folders to share with other
members of your network. Make your data readable or writable for users from any
Windows or Linux workstation. Learn more about this in Section 5.3, “Sharing
Folders in Mixed Environments” (page 65).

Managing Windows Files
openSUSE can be configured to integrate into an existingWindows network. Your
Linux machine then behaves like aWindows client. It takes all account information
from the Active Directory domain controller, just as theWindows clients do. Learn
more about this in Section 5.4, “Managing Windows Files” (page 68).

NOTE: Network Share Support in Dolphin

Dolphin is KDE 4's default file manager and most of the network functions
described in this chapter are already integrated. However not all of themmight
work flawlessly—if in doubt, try using Konqueror instead.
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5.1 General Notes on File Sharing and
Network Browsing

Whether and to which extent you can use file sharing and network browsing on your
machine and in your network highly depends on the network structure and on the con-
figuration of your machine. Before setting up either of them, contact your system ad-
ministrator to make sure that your network structure supports this feature and to check
whether your company's security policies permit it.

Network browsing, be it SMB browsing forWindows shares or SLP browsing for remote
services, relies heavily on the machine's ability to send broadcast messages to all clients
in the network. These messages and the clients' replies to them enable your machine to
detect any available shares or services. For broadcasts to work effectively, your machine
must be part of the same subnet as all other machines it is querying. If network browsing
does not work on your machine or the detected shares and services do not match with
what you expected, contact your system administrator to make sure that you are con-
nected to the appropriate subnet.

To allow network browsing, your machine needs to keep several network ports open
to send and receive network messages that provide details on the network and the
availability of shares and services. The standard openSUSE is configured for tight se-
curity and has a firewall up and running that protects your machine against the Internet.
To adjust the firewall configuration, you would either need to ask your system admin-
istrator to open a certain set of ports to the network or to tear down the firewall entirely
according to your company's security policy. If you try to browse a network with a re-
strictive firewall running on your machine, Dolphin warns you about your security re-
strictions not allowing it to query the network.

5.2 Accessing Network Shares
Networking workstations can be set up to share folders. Typically, files and folders are
marked to let remote users access them. These are called network shares. If your system
is configured to access network shares, you can use your file manager to access these
shares and browse them just as easily as if they were located on your local machine.
Whether you have only read access or also write access to the shared folders depends
on the permissions granted to you by the owner of the shares.
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To access network shares, or open Dolphin and enter remote:/ in the location bar.
Dolphin then opens a virtual folder that displays the network share types that you can
access. Click a network resource type then click the network share to access. You might
be required to authenticate to the resource by providing a username and password.

Figure 5.1 Network Browsing

5.3 Sharing Folders in Mixed
Environments

Sharing and exchanging documents is a must-have in corporate environments. Dolphin
offers you file sharing with Samba, which makes your files and folders available to
both Linux andWindows users. For information on how to install and configure Samba,
refer to Chapter 25, Samba (↑Reference). After Samba is installed, configure Samba
file sharing with Dolphin as follows:

1 Open Dolphin.

2 SelectHomeFolder, right-click thewindow background and then selectProperties
from the context menu.
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3 In the Properties dialog, click the Share tab. When file sharing is not yet gener-
ally enabled, you are informed about this on the tab. To enable file sharing or
select the files to share, click Configure File Sharing and enter the root pass-
word.

4 To enable or disable file sharing, select or deselect Enable Local Network File
Sharing.

Figure 5.2 Enabling File Sharing

5 Select the appropriate sharing option: Simple sharing or Advanced sharing.

6 To limit the number of users allowed to share folders to certain groups, click
Allowed Users, selectOnly users of a certain group are allowed to share folders,
clickChoose Group, and select the appropriate group from the list in the window
that opens. Click OK to close that window.

7 In the file sharing dialog, add the folder to share to the list of shared items by
clicking Add at the bottom of the dialog and specifying the folder's exact path.
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Figure 5.3 Detailed Sharing Options

8 Activate Share with Samba to enable Samba file sharing. If needed, apply some
fine-tuning to the Samba options:

Name
Specify a name other than the preset default.

Public/Writable
Determine which kind of access to grant others to your share. You can grant
users full read and write access or limit their access to just reading your
shares.

9 Apply your settings and leave the file sharing dialog with OK.

The folder now appears in Dolphin with a globe icon.
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Figure 5.4 Shared Folder

To revoke the share, enter the file sharing dialog again and remove the folder
from the list of shared items. The folder then appears without a globe icon.

Other members of your network can reach your share by entering smb:/ in the location
bar of Dolphin and clicking the appropriate workgroup icon and hostname.

IMPORTANT: Samba Domain Browsing

Samba domain browsing only works if your system's firewall is configured ac-
cordingly. Either disable the firewall entirely or assign the browsing interface
to the internal firewall zone. Ask your system administrator about how to
proceed.

5.4 Managing Windows Files
With your openSUSE machine being an Active Directory client as described in Chap-
ter 5, Active Directory Support (↑Security Guide), you can browse, view, andmanipulate
data located on Windows servers. The following examples are just the most prominent
ones:

Browsing Windows Files with Dolphin
Use Dolphin's smb:/ browsing option to browse your Windows data.
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Viewing Windows Data with Dolphin
Use Dolphin to display the contents of yourWindows user folder just as you would
for displaying a Linux directory. Create new files and folders on the Windows
server.

Manipulating Windows Data with KDE Applications
KDE applications, such as the Kate text editor, allow you to open files on the
Windows server, manipulate them, and save them to the Windows server.

Single-Sign-On
KDE applications, including Dolphin, support Single-Sign-On, which means that
to access other Windows resources, such as Web servers, proxy servers, or group-
ware servers like MS Exchange, you do not need to reauthenticate. Authentication
against all these is handled silently in the background once you provided your
username and password on login.

To access your Windows data using Dolphin, proceed as follows:

1 Press Alt + F2 and enter smb:///

This opens a Dolphin window displaying all Samba workgroups and domains
that could be found in your network.

2 Click the icon of the workgroup or domain of your AD server.

Figure 5.5 Browsing Data on the AD Server
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3 Click the Users folder and select your personal user folder icon. The contents of
your My Documents folder are displayed.

To create folders in your Windows user folder using Dolphin, proceed as you would
when creating a Linux folder:

1 Right-click the background of the Dolphin folder view to open the menu.

2 Select Create New > Folder.

3 Enter the new folder's name when prompted to do so.

To create a file on the AD server, proceed as described in the following example for
the Kate text editor.

1 Press Alt + F2 and enter kate.

2 Enter your text.

Figure 5.6 Editing a Text File with Kate

3 To save the newly created text, select Save as.

4 Click the Network Folders icon to the left and select SMB Shares.
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Figure 5.7 Saving a File to a Remote Windows Folder

5 Navigate to your Windows folder.

6 Enter the filename and click Save.

The file is saved on the Windows server.

Make use of Dolphin's Single-Sign-On support, as in the following example—Web
access to your MS Exchange mailbox:

1 Make sure that you have a valid MS Exchange account under your current Win-
dows user identity.

2 Request the Exchange server's address from your system administrator.

3 PressAlt+ F2 and enterdolphinhttp://address_exchange_server.

You are logged in to your Exchange account without having to reauthenticate.

Accessing Network Resources 71



Figure 5.8 Accessing MS Exchange through Dolphin

4 Write or read your e-mails and log out as usual.
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6Searching with Kerry
Kerry is a KDE front-end for the Beagle search tool, which indexes your personal in-
formation space to help you find whatever you need. You can use Kerry to find docu-
ments, e-mails, Web history, IM/ITC conversations, source code, images, music files,
applications, and much more.

Because Kerry is a front-end to Beagle, it needs the beagle daemon to be functional.
Kerry and Beagle can now index many KDE-specific sources of information, such as
Kopete conversations, Konqueror history, or KMail messages. The result is a smooth
integration into the KDE environment through the Kerry interface. Find more about
Beagle in Chapter 6, Searching with Beagle (↑GNOME User Guide).

6.1 Searching Using Kerry
To find data using the Kerry tool, follow these steps:

1 Press Alt + F2 and enter kerry to start Kerry and to open the Kerry Beagle
Search window. Alternatively, open the search window by left-clicking on the
Kerry applet icon (a dog's head) in the system tray.

2 Enter the term to find in Search. To quickly clear the previously entered text,
press the black arrow on the left.

The search is case insensitive. It does not matter whether you use uppercase or
lowercase characters. To search for optional terms, use the OR keyword (in up-
percase). For example,Mars OR Venus finds all data containing any occurrence

Searching with Kerry 73



of Mars, Venus, or both. To exclude search terms, use a minus symbol (–) in
front of them. For example, Mars -Venus finds all data containing any occur-
rence ofMars but without any occurrence of Venus. To search for an exact phrase,
enclose the phrase in quotes. If you want to include only certain file type in results,
specify the filename extension with ext:. For example, Mars ext:xml finds
xml files containing Mars.

3 Select the scope of the search in the Show section of the right panel. To search
all the indexed content, choose Everything. However, you can limit the search
only to indexed Applications, Contacts, Office documents, instant messenger
Conversations, Images,Media files,Web pages, or File/Path names by clicking
the appropriate item in the panel. You can change the scope before or after the
search is performed.

Change the sort order of results in the Sort By section of the right panel. To sort
results by type, click Type. Sorting byDate,Name, and Relevance is also possible.
You can change the sort order before or after the search is completed.

You can limit the results by date of last modification. To show all results regard-
less of the date of the last modification, click Any Date in the right panel. You
can show items modified today, since yesterday, this week, month, or year by
clicking the appropriate item in the right panel. You can change this before or
after the search is performed.

4 Press Enter or click the icon to the right of the search field to start the search.
Results are displayed in the main area of the window.

Results are displayed in a window, sorted according to your settings. Click any item to
activate it. To open a folder containing a found file instead of the file itself, click the
name of the folder to the right of the filename. To display more information about an
item, click the icon with the i on the left.

You can change the scope of the search, sort order, or limitation by date at any time by
clicking appropriate item in the panel on the right.

Use Previous results and Next results to move between pages of the result list. The
number of items found is shown in the bottom part of the window.
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6.2 Configuring Kerry
You can configure Kerry by right-clicking its icon in the tray and choosing Configure
Kerry or by clicking Configure in Kerry's main window. The configuration dialog has
four tabs.

On the Search tab, you can change the Default result sort order, Maximum number of
results displayed on one page, or shortcuts for activating Kerry Beagle Search.

On the Indexing tab, set whether the Beagle indexing service should be started automat-
ically and whether data should be indexed while the computer is operating on battery
power. You can also determine which folders should be indexed by Kerry Beagle Search
and which folders should not be indexed at all. See Section 6.2.1, “Indexing More Di-
rectories” (page 75) and Section 6.2.2, “Preventing Files and Directories from Being
Indexed” (page 76) for detailed instructions.

On theBackends tab, choose which of the available Beagle back-ends should be enabled.
To disable a back-end, uncheck it. For example, if you do not want your Kopete con-
versations be indexed by Kerry Beagle, uncheck the Kopete back-end.

On the Daemon Status tab, check the status of Beagle daemon. You can stop or start
the daemon manually here. To use Kerry Beagle Search functionality, the daemon must
be running.

6.2.1 Indexing More Directories
By default, Kerry indexes your home folder only. If you do not want your home folder
to be indexed, uncheck the Index my home folder option on the Indexing tab of the
Kerry configuration. To index more folders, follow these steps:

1 If the Kerry Beagle configuration dialog is not open yet, right-click the Kerry
icon in the tray and choose Configure Kerry.

2 Click the Indexing tab.

3 Click the Add button in the middle part (Index) of the tab.

4 In the dialog that opens, choose the folder to index and click OK.
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5 Press OK.

6.2.2 Preventing Files and Directories from
Being Indexed

To exclude some folders or files from being indexed by Kerry, follow these steps:

1 If the Kerry Beagle configuration dialog is not open yet, right-click the Kerry
icon in the tray and choose Configure Kerry.

2 Click the Indexing tab.

3 Click Add in the bottom part (Privacy) of the tab.

4 In the dialog that opens, choose a folder not to index by selecting the Folder
option. Specify the path to the folder in the text field or press the folder button
and choose the folder in a file dialog.

You can also specify files not to index by selecting File name pattern and speci-
fying the file pattern.

5 Press OK.
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7Managing Print Jobs
Printers can either be connected to your system locally or accessed over a network.
There are several ways to set up a printer in openSUSE: with YaST, or on the command
line. There are also desktop tools in KDE or GNOME for setting up printers but we
recommend to use YaST for this task.

Refer to Section “Setting Up a Printer” (Chapter 2, Setting Up Hardware Components
with YaST, ↑Start-Up) for detailed information how to configure printers with YaST.

NOTE: Troubleshooting

If you have problems configuring your printer, ask your system administrator.
An in-depth coverage of printer configuration for administrators can be found
in Chapter 9, Printer Operation (↑Reference).

This chapter describes how to set up printers with the KDE Printing Manager. After
configuring the printer correctly, you can address it from any application.

7.1 Starting Print Jobs in KDE
In KDE, you usually start print jobs with KPrinter. This application is started automat-
ically each time you print from a KDE application. In the KPrinter dialog, choose a
printer and edit the Properties of your print job, such as page orientation, pages per
sheet, and duplex printing.
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TIP: Sending Files to a Printer without Opening the Application

You can also start KPrinter manually by pressing Alt + F2 and entering
kprinter. This is useful if you want to print one or several files without
starting the application to view or edit the file. The KPrinter dialog then addi-
tionally includes the Files tab, where you can determine the files to print. Either
drag them from the desktop and drop them into the list or use the file dialog
to locate them.

To specify the number of copies and various other options, click Expand at the bottom
left. The window then expands and shows three tabs: Copies, Advanced Options, and
Additional Tags. See Figure 7.1, “Starting a Print Job with KPrinter” (page 78).

Figure 7.1 Starting a Print Job with KPrinter

The Copies tab determines the page selection (all pages of the selected document, the
currently selected one, or a range) and the number of copies. You may also choose to
print only the even or only the odd numbered pages of the selected document. Use Ad-
vanced Options to specify any additional information for the print job. Enter any Billing
information if needed or set a custom page label at the top and bottom of the page. The
Job Priority can also be set here. The last tab, Additional Tags is rarely needed. Once
your print job has been filed, you can watch its progress using KJobViewer.
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7.2 Monitoring Print Jobs in KDE
Start KJobViewer from the main menu or with kjobviewer from the command line.
A window like that in Figure 7.2, “Monitoring Print Jobs with KJobViewer” (page 79)
opens, listing all the print jobs queued on your printer. As long as your print job is not
active, you can edit it. Do this using the entries of the Jobs menu.

Figure 7.2 Monitoring Print Jobs with KJobViewer

If, for example, you want to check if you sent the correct document to the printer, you
can stop the job and resume it if you decide to print it. Remove your own print jobs
from the queue with Remove. To change the printer, select a different printer withMove
to Printer.

With Restart, reprint a document. To do this, select Filter > Toggle Completed Jobs,
select the desired document, and click Jobs > Restart. Clicking Jobs > Job IPP Report
shows the technical details of a job. Use Jobs > Increase Priority and Jobs > Decrease
Priority to set the priority, depending on how quickly you need the document.

Filter enables you to switch between various printers, toggle completed jobs, and limit
the view to your own print jobs by selecting Show Only User Jobs. The current user is
then displayed in the top right field.

Settings > Configure KJobViewer opens a configuration dialog. Here, determine the
maximum number of print jobs to display. Enter a number in the field or use the slider
to the right to determine a value. PressOK to save the setting orCancel to exit the dialog
without saving.

Managing Print Jobs 79



The icons in the toolbar correspond to the functions you can access by way of the menu.
Display a help text explaining the function by holding the mouse pointer over one of
the icons.

The job list consists of eight columns. The job ID is automatically assigned by the print
system to identify the various jobs. The next column contains the login of the user who
sent the job followed by the filename of the document. The status column indicates
whether a job is still in the queue, currently being printed, or already completed. Next,
the size of the document is displayed in kilobytes and number of pages. The default
priority of 50 can be increased or reduced if necessary. Billing information can be cost
centers or other company-specific information. If you right-click a job in the list, the
Jobsmenu opens under the mouse pointer, allowing you to select an action. Only a few
functions are available for completed jobs. If you activate Keep window permanent,
KJobViewer opens automatically the next time you log in.
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8Managing Passwords with
KWallet Manager
Remembering all the passwords for protected resources to which you need to log in
can be problematic. KWallet remembers them for you. KWallet is a password manage-
ment tool that can collect all passwords and stores them in an encrypted file. With a
single master password, open your wallet to view, search, delete, or create entries.

IMPORTANT: Protect Your KWallet Password

If you forget your KWallet password, it cannot be recovered. Furthermore,
anyone who knows your password can obtain all information contained in the
wallet.

8.1 Starting KWallet
When you enter a password in a KDE application for the first time (in KMail or Kon-
queror, for example), you are asked if you want to store the password in an encrypted
wallet. If you click Yes, KWallet wizard starts by default. KWallet is a password man-
agement tool that can collect all passwords and store them in an encrypted file.
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To activate KWallet, select Basic Setup and click Next. Select Yes, I wish to use the
KDE wallet to store my personal information and enter a password. This is your master
password to open KWallet. It cannot be recovered if you forget it. Click Finish to close
the wizard. After this initial configuration, you can open your wallet at any time to
view, search, delete, or create entries. Normally you do not need to insert an entry
manually. KDE recognizes if a resource requires authentication and KWallet starts au-
tomatically, prompting you for the KWallet password. Of course, you can also use
KWallet to store additional passwords by adding entries, as described in Adding New
Entries to Your Wallet (page 83).

By default, all passwords are stored in one wallet, kdewallet, but you can also add new
wallets. Once configured, KWallet appears in the panel. You can also start KWallet
manually by pressing Alt + F2 and entering kwalletmanager.

8.2 Managing Your Passwords
To store data in your wallet or view its contents, click the KWallet icon in the panel.
A dialog box opens, showing the wallets that are accessible on your system. Click the
wallet to open. A window prompts for your password.

After a successful login, the KWallet Manager window opens. In the tree view on the
left, navigate to the entry for which you want to view or change the password. For
safety reasons, the password value is hidden by default when you click the entry. For
passwords, click Show Contents. For maps, containing key and value pairs (like a
WLAN ESSID and your password), activate Show Values to view the contents.
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Figure 8.1 The KWallet Manager Window

Procedure 8.1 Adding New Entries to Your Wallet

1 To manually add new passwords (or maps) to KWallet, select the subfolder to
which to add an entry in the tree folder at the left.

2 To add a new password, right-click a Passwords entry and select New from the
context menu.

To add a new key pair (map), right-click aMap entry and select New from the
context menu.

3 Specify a name for the new entry then click OK. Your new entry is sorted under
your folder entry.

4 Click the new entry to display it on the right side (the folder is initially empty).

5 Click Show Contents or Show Values to open an input field where you can enter
your new password or values.

6 To add a key pair, right-click the empty input field and select New Entry Type
in your password (or you key and respective value for that key) and click Save.
KWallet saves your entry to the subfolder selected.
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Procedure 8.2 Changing the Password for a Wallet

If needed, you can change your password for a wallet at any time.

1 Open KWallet Manager and right-click the wallet for which to change the pass-
word.

2 Select Change Password.

3 Enter your new password twice.

8.3 Adjusting KWallet Settings
By default, you define the settings for KWallet password manager with the help of a
wizard when you use KWallet for the first time. You can adjust the initial settings at
any time to increase security.

1 If KWallet is already started, click the KWallet symbol in the panel and select
Configure Wallet. Otherwise, in the main menu, select Configure Desktop and
on the Advanced tab, click KDE Wallet.

2 If KDE wallet subsystem is not yet enabled, activate the respective check box at
the top.

3 By default, a wallet is closed when the last application stops using it. To increase
security, you can set a more restrictive policy: to close a wallet automatically
after a period of inactivity or after start-up of the screen saver, activate the respec-
tive check boxes.
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4 By default, KWallet stores all passwords in one wallet named kdewallet. To
store local and network-related passwords in different wallets, activateDifferent
wallet for local passwords. Click New to create an additional wallet, if needed.

5 To remove the KWallet icon from the panel, deactivate Show manager in system
tray. You can then only access KWallet from the main menu.

8.4 Copying Your Wallet to Another
Computer

For the most part, KWallet resides silently in the panel and is automatically activated
if needed. However, you can copy your wallet files to another computer (for example,
your laptop). To simplify this task, wallets can be dragged from the manager window
to a file browser window. This let you easily package a newwallet for transfer to another
environment. For example, a new wallet could be created and copied onto a removable
flash memory device. Important passwords could be transferred there, so you have them
available in other locations.
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9Controlling Your Desktop’s
Power Management
In KDE 4, you can control power management functions supported by your system
with just a few clicks on the desktop. You can choose between various power manage-
ment profiles to match the tasks your system is facing. The Personal Settings hold a
Power Management category, allowing you to configure detailed settings as described
in Section 9.3, “Configuring Power Management” (page 89).

Apart from power profiles that can be applied while you are interacting with your
computer, there are also power saving functions (suspend modes) you can use instead
of shutting down the computer completely during breaks.

9.1 Using the Battery Monitor Widget
If you are using mobile computers like a laptop, a widget in your panel displays the
battery status and gives you access to power management functions. If the Battery
Monitor widget is not displayed in your panel by default, add it manually. For more
information, refer to Adding Widgets to the Desktop (page 41).

The widget allows you control the screen brightness when your system is running on
battery power, to switch to a different power profile, or to trigger your system to enter
a suspend mode. Click the panel icon to open the widget.
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Figure 9.1 Battery Monitor Widget

Which suspend modes and power profiles are available, depends on the power manage-
ment abilities of your system and the profiles defined in the Personal Settings.

The following suspend modes are widely available:

Sleep (Suspend to RAM)
Pauses your computer without logging you out. All your data and the session data
is saved to RAM. Bringing the system up again is faster than restoring a session
from disk.

Hibernate (Suspend to Disk)
Pauses your computer without logging you out. All your data and the session data
is saved to disk before the system is laid to rest. It is thus protected against data
loss should you loose power in the meantime. Waking the system up again is much
faster than booting it from scratch.

Tomanually suspend your computer, use the buttons in the widget or the suspend options
on logging out (see Section 1.3, “Leaving Your System” (page 11)). If supported by
the system and configured accordingly, pressing sleep buttons on your machine or
keyboard will also suspend your machine.

You can configure your system to automatically switch into a suspendmode after certain
events like closing the lid (if you are using a laptop) or after a period of that time that
the system has been idle. Refer to Section 9.3, “Configuring Power Management”
(page 89) for more information.
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9.2 Saving Power by Using Profiles
Power management profiles let you adjust various power management parameters to
the requirements of certain typical situations you are facing when using your machine.
openSUSE® ships with a set of four preconfigured profiles which you can adjust to
your needs. To switch profiles click the battery monitor panel icon and select a different
Power Profile. The following profiles are available by default:

Performance
Keep your machine running with full power and full speed to achieve maximum
performance.

Presentation
Disable any display power management and screen savers to make sure that your
presentation is not interrupted by a blanked display or such like.

Powersave
Apply power management methods to make sure that your machine runs as long
as possible when put on battery power instead of AC power.

Aggressive Powersave
Use stricter power management methods to be applied when the battery is at low
level. This includes shorter idle intervals before triggering suspend events, reducing
screen brightness, disabling 3D effects and using CPU scaling policies that preserve
resources.

Xtreme Powersave
Apply extreme power saving by reducing screen brightness even more and using
stricter idle time and CPU scaling policies when the battery is already at warning
level.

9.3 Configuring Power Management
KDE 4 lets you adjust a number of power management settings: for example, when to
trigger notifications or warnings, which power profile to use when running on battery,
what to do when closing the laptop lid or pressing the power or sleep button.

Controlling Your Desktop’s Power Management 89



Access the configuration options from the main menu by selecting Configure Desktop
> Advanced > Power Management. Alternatively, click the battery monitor icon in the
panel and click select Configure.

Figure 9.2 Power Management Settings

To get on overview of your system's power management abilities like supported suspend
methods or CPU policies, click Capabilities. Click the other categories to configure
general settings and power management profiles.
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Procedure 9.1 Configuring General Settings

1 In the General Settings category, decide if the screen should be locked after a
suspend action, so that the user needs to type in his password when the machine
resumes after a suspend.

2 Configure which notification or warnings you want to receive for certain events
like low battery status, or if you want suspend actions to be executed at once or
only after a certain time interval.

3 Decide which power profiles should be applied by default when the system is
running on AC power, on battery, or when the battery is low or at warning level.

4 Click Advanced Battery Settings if you want to fine-tune the battery levels that
are regarded as low or critical or to define which action should be taken at a
critical battery level.

5 For detailed information about the available options, click Help.

6 If all options are set according to your wishes, click Apply.

Procedure 9.2 Configuring Power Management Profiles

Apart from the general settings, you can adjust the default power management profiles
or add new profiles in the Edit Profiles category.

1 Click one of the available profiles in the list to view or change the specific settings
for that profile: which Actions are taken when the lid of the laptop is closed or
the Power or Sleep button is pressed, how much the Screen is dimmed and after
howmanyminutes the display is turned off automatically. ClickCPU and System
to view or change which CPU to turn off (if supported by your machine) or to
set the CPU frequency scaling policy for that profile.

2 Use the icons at the bottom of the list with profiles if you want to add, delete,
import or export power management profiles.
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AGNU Licenses
This appendix contains the GNUGeneral Public License and the GNU Free Documen-
tation License.

GNU General Public License
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public License is intended
to guarantee your freedom to share and change free software--to make sure the software is free for all its users. This General Public License applies to
most of the Free Software Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software Foundation
software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

Whenwe speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom
to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions
translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the
software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program will individu-
ally obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone’s
free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.



GNUGENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTIONANDMODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the
terms of this General Public License. The “Program”, below, refers to any such program or work, and a “work based on the Program” means either the
Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications
and/or translated into another language. (Hereinafter, translation is included without limitation in the term “modification”.) Each licensee is addressed
as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program
is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been
made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium, provided that you conspicuously
and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such
modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to
be licensed as a whole at no charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the
most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying
that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License.
(Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to
print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as
separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must
be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who
wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to
control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a
storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections
1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2
above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing
source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for
noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b
above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means
all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation
of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source
or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the
source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with
the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy,
modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.
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5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the
Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the
Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, dis-
tributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor
to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients’ exercise
of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are
imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions
of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as
a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program
by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain en-
tirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the
section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many
people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright
holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution
is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and “any later
version”, you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foun-
dation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask
for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimesmake exceptions
for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing
and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT
PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER
PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
ENTIRERISKASTOTHEQUALITYANDPERFORMANCEOFTHEPROGRAMISWITHYOU.SHOULDTHEPROGRAMPROVEDEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR
ANY OTHER PARTY WHOMAYMODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE
ORLOSSES SUSTAINEDBYYOUORTHIRDPARTIESORAFAILUREOFTHEPROGRAMTOOPERATEWITHANYOTHERPROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

one line to give the program’s name and an idea of what it does. Copyright (C) yyyy name of author
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This program is free software; you can redistribute it and/or
modify it under the terms of the GNU General Public License
as published by the Free Software Foundation; either version 2
of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details
type `show w’. This is free software, and you are welcome
to redistribute it under certain conditions; type `show c’
for details.

The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the General Public License. Of course, the commands you use
may be called something other than `show w’ and `show c’; they could even be mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the program, if necessary.
Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright
interest in the program `Gnomovision’
(which makes passes at compilers) written
by James Hacker.

signature of Ty Coon, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the GNU Lesser General Public
License [http://www.fsf.org/licenses/lgpl.html] instead of this License.

GNU Free Documentation License
Version 1.2, November 2002

Copyright (C) 2000,2001,2002 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

PREAMBLE
The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the sense of freedom: to assure everyone
the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves
for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free in the same sense. It complements
the GNU General Public License, which is a copyleft license designed for free software.
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We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should
come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any
textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose
is instruction or reference.

APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright holder saying it can be distributed under
the terms of this License. Such a notice grants a world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated
herein. The “Document”, below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications
and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or
authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject.
(Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter
of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the
Document is released under this License. If a section does not fit the above definition of Secondary then it is not allowed to be designated as Invariant.
The Document may contain zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document
is released under this License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specification is available to the general public,
that is suitable for revising the document straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for
drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or absence of markup, has been arranged to
thwart or discourage subsequent modification by readers is not Transparent. An image format is not Transparent if used for any substantial amount of
text. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML
using a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF designed for human modification. Examples of transparent
image formats include PNG, XCF and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word processors,
SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced
by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires
to appear in the title page. For works in formats which do not have any title page as such, “Title Page” means the text near the most prominent appearance
of the work’s title, preceding the beginning of the body of the text.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in parentheses following text
that translates XYZ in another language. (Here XYZ stands for a specific section name mentioned below, such as “Acknowledgements”, “Dedications”,
“Endorsements”, or “History”.) To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may includeWarranty Disclaimers next to the notice which states that this License applies to the Document. TheseWarranty Disclaimers
are considered to be included by reference in this License, but only as regards disclaimingwarranties: any other implication that theseWarranty Disclaimers
may have is void and has no effect on the meaning of this License.

VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices,
and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to
those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions
in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

COPYING IN QUANTITY
If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more than 100, and the Document’s
license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on
the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition.
Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim
copying in other respects.
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If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover,
and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy
along with each Opaque copy, or state in or with each Opaque copy a computer-network location fromwhich the general network-using public has access
to download using public-standard network protocols a complete Transparent copy of the Document, free of added material. If you use the latter option,
you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus
accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of
that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a
chance to provide you with an updated version of the Document.

MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified
Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the
Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if
there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version
gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together
with at least five of the principal authors of the Document (all of its principal authors, if it has fewer than five), unless they release you from this require-
ment.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this
License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document’s license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year, new authors, and publisher of the
Modified Version as given on the Title Page. If there is no section Entitled “History” in the Document, create one stating the title, year, authors, and
publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network
locations given in the Document for previous versions it was based on. These may be placed in the “History” section. You may omit a network location
for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and preserve in the section all the substance
and tone of each of the contributor acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered
part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the
Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version’s license notice. These titles must be distinct from any other section titles.

Youmay add a section Entitled “Endorsements”, provided it contains nothing but endorsements of yourModified Version by various parties--for example,
statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of
Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements
made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the
same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher
that added the old one.
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The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement
of any Modified Version.

COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions,
provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant
Sections of your combined work in its license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there
are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in
parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles
in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming one section Entitled “History”; likewise
combine any sections Entitled “Acknowledgements”, and any sections Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

COLLECTIONS OF DOCUMENTS
Youmaymake a collection consisting of the Document and other documents released under this License, and replace the individual copies of this License
in the various documents with a single copy that is included in the collection, provided that you follow the rules of this License for verbatim copying
of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you insert a copy of this License
into the extracted document, and follow this License in all other respects regarding verbatim copying of that document.

AGGREGATION WITH INDEPENDENT WORKS
A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution
medium, is called an “aggregate” if the copyright resulting from the compilation is not used to limit the legal rights of the compilation’s users beyond
what the individual works permit. When the Document is included in an aggregate, this License does not apply to the other works in the aggregate which
are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one half of the entire aggregate,
the Document’s Cover Texts may be placed on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the
Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole aggregate.

TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing Invariant
Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections
in addition to the original versions of these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the original versions of those notices and
disclaimers. In case of a disagreement between the translation and the original version of this License or a notice or disclaimer, the original version will
prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (section 4) to Preserve its Title (section 1)
will typically require changing the actual title.

TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy,
modify, sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License “or
any later version” applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has
been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation.

ADDENDUM: How to use this License for your documents
To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices
just after the title page:

Copyright (c) YEAR YOUR NAME.
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Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.2
only as published by the Free Software Foundation;
with the Invariant Section being this copyright notice and license.
A copy of the license is included in the section entitled “GNU
Free Documentation License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with...Texts.” line with this:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your choice of free software
license, such as the GNU General Public License, to permit their use in free software.
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